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National Science Education Standards?! covered:

1. Physical Science- Properties and changes of properties in matter
In this education module, we demonstrate how simply changing the weight % of gelatin incorporated
within hydrogel network can alter material properties of the resulting network. Using simple hands-
on activity, students will understand the concept of elasticity, mesh size (vacant spaces between
crosslinks which can be occupied by water), diffusivity and will appreciate how these properties can
be controlled.

2. Life Science- Structure and function in living systems
In our education module, we draw correlation between structure and properties of various tissues in
the body and how synthetic biomaterials can be designed to match these properties (and control
function). Students will learn about the differences in the stiffness of bone, muscle, and fat tissue and
will understand how hydrogel biomaterials can be designed to match these tissues. Students will
also learn about stem cells, their role in the body, and how their environment (specifically, material
stiffness) affects their function.

3. Science and Technology- Abilities of technological design
Students will learn about the importance of designing biomaterials such that their physical properties
match that of the tissue they are replacing, and will identify potential applications of biomaterials of
varying stiffnesses as replacements for specific tissues within the body. They will learn how technical
design considerations such as hydrogel composition can be modified for each biomaterial
application.

4. Science in Personal and Social Perspectives- Science and technology in society

In our simple demonstration using food coloring and biomaterial hydrogels of varying stiffness, we
show how diffusion of drug can be controlled within biomaterials. We use food coloring as model
drug and investigate both qualitatively and quantitatively the diffusion of food coloring within
hydrogels of varying stiffness, thereby understanding how simple science concepts can be translated
into technology and can be used to cure diseases and improve the quality of life. Students will draw
relationships between the scientific principals observed in the module and therapeutic applications in
healthcare.

'National Research Council. National Science Education Standards. Washington, DC: The National
Academies Press, 1996 (ISBN-10: 0-309-05326-9)
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Learning Objectives:

“How Stiff am 1? Modifying Hydrogel Properties for Tissue Engineering & Stem Cell Delivery”

Tissues have varying material properties (stiffnesses) based on their functions

Matching biomaterial and host tissue properties is a critical design consideration in tissue
engineering

Hydrogels are highly crosslinked, hydrophilic networks

Hydrogel mesh sizes and stiffnesses can be controlled by varying gel composition

Stem cells are an exciting, versatile cell type that can be used for a variety of therapeutic
applications

Stem cell behavior (differentiation) can be controlled by altering biomaterial properties

Biomaterials such as hydrogels can be used to deliver stem cells for therapeutic applications

“How Quick am 1? Modifying Hydrogel Properties for Controlled Drug Delivery”

Biomaterials such as hydrogels can be used to deliver drugs

Diffusion is the process where molecules move from areas of high to low concentration

Hydrogel mesh size can be used to control the rate of drug diffusion within hydrogels

Material properties such as mesh size can be altered to control drug release for therapeutic
applications

Collection and graphical representation of data can provide useful insight to the biomaterial system
being investigated

Scientific Vocabulary Learned:

Biomaterials Hydrogels Myogenic Self-renewal
Crosslinking Hydrophilic Neural Stem Cell
Differentiation Hydrophobic Neurogenic Tissue Engineering
Diffusion Mesh Size Osteogenic Weight Percent
Drug Delivery Modulus of Elasticity Polymer

Fundamental Biomaterials Questions Answered:

What is a biomaterial?

What is a hydrogel?

How are hydrogels formed?

What is diffusion?

What is a stem cell?

What is tissue engineering?

What is regenerative medicine?

What is drug delivery?

Why is it important to control the properties of a biomaterial?
How can biomaterial properties (like stiffness) be controlled?
How can biomaterials be used with stem cells?

How can biomaterials be used to control drug delivery?

How can biomaterial properties be altered to control drug release?
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Required and Provided Resources:

“How Stiff am 1? Modifying Hydrogel Properties for

Tissue Engineering & Stem Cell Delivery”

;2:21?? or alternate colored 3 boxes, in different colors Grocery store 2.25
Measuring cups 1 set Grocery store 5
Mixing bowls 3 Grocery store 3
Ice cube trays 3 Grocery store 7
Re-sealable containers 3 Grocery store 3
Chicken ;iévcheosle chicken, cutinto Grocery store 5
Gloves 1 box Grocery store 4
Background Material 1 Download online 0
Script 1 Download online 0

Table 1: Required materials, sources, and cost estimates for Jell-O ® based demo. All amounts and costs are based on
a class of 25 students. Classrooms are assumed to have free access to: water, a microwave, refrigerator,
printing/copying equipment, standard cutlery, and paper towels. Recurring costs are indicated in bold.

“How Quick am I? Modifying Hydrogel Properties for

Controlled Drug Delivery”

l}ig:)l)a(léored gelatin, such as 1 Grocery store 0.75*
Petri dish or clear flat bottom dish | 4 Online 10
Food coloring 1 Grocery store 0.25*
Stopwatch/wristwatch 4 10 40**
Digital Camera 1, Optional Online 25
Background Material 1 Download online 0
Script 1 Download online 0
Assessment worksheet 25 Download online 0

Table 2: Required materials, sources, and cost estimates. Classrooms are assumed to have all materials from the stem
cell portion of the module. Recurring costs are indicated in bold. *Purchasable volumes contain enough material for
multiple module iterations; costs given as per 25 students. **Classroom clock can be used as a cost-saving alternative.

Total Estimated Costs per 25-Student Classroom:
»  Setup cost: $20-80
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e Recurring cost: $20

Teaching Resources Provided:
» Summary of scientific background
» References to relevant literature for additional background knowledge
» Required materials, suggested sources, and cost estimates
» Cost-saving alternative methods
e Detailed instructions for module preparation and setup
» Detailed script for classroom activities
e Clearly defined learning objectives
» List of relevant scientific vocabulary
e Suggestions for advanced modifications to further enhance student comprehension and involvement
» Post-module assessment worksheet and key
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Background Material:

Hydrogels are hydrophilic polymer networks that absorb water within their crosslinked mesh. Hydrogels
can be either natural (i.e. agarose, hyaluronan) or synthetic (i.e. poly(ethylene glycol)) and are widely used
as biomaterials that improve, mimic, or replace important components of the human body. For example,
contact lenses are hydrogel networks (usually polyacrylamides) engineered to correct vision. One of the
most promising areas of biomaterial development is the use of hydrogels as scaffolds for tissue
engineering (1). The emergence of hydrogels in tissue engineering applications has been driven by an
overwhelming (and increasing) number of patients that require organ therapy (treatment, removal,
transplantation). Synthetic hydrogels are particularly attractive for tissue engineering applications because
they have tunable physical, biological, and mass transport properties (1).

For tissue engineering applications, physical properties are of great importance because they dictate the
mechanical interaction of the implanted biomaterial (hydrogel) with the surrounding cells, matrix, and tissue
(bone, cartilage, tendon, neurons). Matching mechanical properties of the hydrogels to the surrounding
host tissue is important and can prevent shear degradation (or fracture) of the implanted hydrogel or host
tissue. Hydrogels can be tailored to possess a specific stiffness, toughness, and/or elasticity by altering the
chemical composition of the network, the type of crosslinker used, the reaction time, and the weight percent
of monomer in the hydrogel precursor solution. The hydrogel network is formed when macromer chain
ends are activated (usually with an initiator) and allowed to bond with a crosslinking agent to produce an
interconnected scaffold with a characteristic “mesh size.” For a given hydrogel composition, the mesh size
(distance between crosslinks) controls the physical strength (stiffness) and degree of water infiltration
(swelling of hydrogel). The Flory-Rehner equation allows for calculation of hydrogel mesh size based on
some known properties of the polymer network, such as the degree of swelling (2).

Importantly, a multitude of other components can be included in the hydrogel precursor solution that, upon
polymerization, will be present within the hydrogel mesh. These components include (but are not limited to)
proteins, growth factors, cytokines, chemokines, and living cells. Therefore, hydrogel scaffolds (already
containing living cells and growth factors) can be implanted to supplement the cell and tissue resources at
the site of injury to aid in healing. Furthermore, the cytocompatible (non-toxic to cells) nature of the
hydrogel polymerization allows for formation of the therapeutic scaffold within the body at the point of
interest (surrounding a fractured bone, around a severed neuron, within a damaged heart, etc.).

The ability to easily tune the physical properties of hydrogels allows further control over the cellular
microenvironment because mechanical properties of crosslinked networks greatly impact cell fate and
behavior. While most cell types will survive the polymerization and encapsulation process, stem cells are
particularly useful because they can be driven down specific lineages to generate specific tissues required
for healing (i.e. bone, muscle, cartilage). Stem cells are immature, multipotent cells capable of undergoing
proliferation, self-renewal, and differentiation (3). Interestingly, stem cells, seeded on the surface of or
encapsulated within hydrogels of different stiffness will differentiate into specific lineages as a result of their
mechanical interaction with their surrounding environment (3). For example, Engler et al. showed
differentiation of stem cells down neurogenic (brain), myogenic (muscle), and osteogenic (bone) lineages
as hydrogel stiffness increased. In addition to controlling the genetic expression of stem cells, the physical
environment provided by the hydrogel scaffold can also modulate stem cell motility (movement) and
phenotype (physical appearance) (3). Control over stem cell fate can be of great use in tissue engineering
because it allows implantation of general multipotent cells (stem cells) that can reliably differentiate into
mature, functional cells of a desired lineage.

Similarly, the physical properties of the hydrogel also greatly affect its mass transport properties. As
previously described, hydrogels can be synthesized to encapsulate proteins, growth factors, cells, and
therapeutic agents (drugs). The release kinetics of this cargo at the implanted site is very important for
therapeutic applications; therefore it is essential to have the ability to adjust the rate of nutrient (or drug,
cell, protein) transport for different applications. The governing equation for mass transport is given below
(Eg. 1) in differential form (also known as Fick’s Law). In Equation 1, J is the molar diffusive flux (the
amount of drug transported per area per unit time, mol/(ms)), D is the diffusion coefficient (m?/s), and [ C
is the molar concentration gradient (mol/m>m).
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J=DOC Eq. (

From Equation 1, it is apparent that the greatest molar diffusive flux (fastest mass transport) will occur for a
molecule with both a large diffusion coefficient and molar concentration gradient. The diffusion coefficient
is a property of the molecule (i.e. drug, protein, etc.), the media it is dispersed in (i.e. water), and the
temperature (higher temperature = higher diffusion coefficient). The concentration gradient is the driving
force behind diffusion-mediated transport. Molecules in a high, localized concentration will undergo mass
transport until the concentration is equal throughout the entire volume (mass is transported from areas of
high concentration to areas of low concentration).

For a given application, the variables in Equation 1 will be equivalent, meaning that modulation of mass
transport and ultimately release of encapsulated molecules will be dependent on the physical properties of
the hydrogel (primarily mesh size). A larger hydrogel mesh size will result in faster molecular release from
the hydrogel because there is more room for water infiltration (swelling), and the molecular path of the
encapsulated drug is less tortuous (more room for the molecular to diffuse out of the hydrogel). Diffusion of
encapsulated materials to the surrounding media will take on a different “effective diffusivity” depending on
the mesh size of the hydrogel. Because mesh size can modulate release based on size, hydrogels can be
engineered to possess “sieve” characteristics to release smaller molecules more rapidly and larger
molecules more gradually. Similarly, the mesh size of a hydrogel can be altered to control how quickly a
single type of drug molecule is released (big mesh size = faster, small mesh size = slower). This concept
can also be applied to dual delivery of drugs (or growth factors) and subsequent release of cells.

The versatility and tunability of hydrogel properties makes them a uniquely attractive platform for many to
tissue engineering applications. While mechanical, biological, and mass transport properties of hydrogels
are interdependent, they can also be individually tailored to satisfy the constraints of more complicated
applications. The use of hydrogel scaffolds has the potential to match mechanical properties to the
implantation site, direct stem cell differentiation towards target cell lineages, and modulate delivery of
additional factors (drugs, proteins, nutrients) in a controlled manner.

REFERENCES:

1. J. L. Drury, D. J. Mooney, Biomaterials 24, 4337 (Nov, 2003).

2. S. P. Zustiak, J. B. Leach, Biomacromolecules 11, 1348 (May 10, 2010).
3. Kshitiz et al., Integr Biol-Uk 4, 1008 (2012).
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Demo #1: How Stiff am 1?

During this demonstration students will investigate how hydrogel biomaterials can be altered to change their
stiffness and thereby simulate the different tissues of the body. Furthermore, students will learn how different
hydrogel stiffness can be used to control stem cell function and development. By conducting a series of thought
experiments in combination with hands on tactile learning, students will gain an understanding of how hydrogels
can be used to therapeutically deliver stem cells in regenerative medicine applications.

Materials

- Jell-O ® (3) (Boxed Jell-O ® Brand — three distinct colors like blue, green, and orange)
- Tap water

- Measuring cup

- Mixing Bowls (3)

- Ice cube trays (3)

- Re-sealable Tupperware Container (3)

- Microwave / Refrigerator

Methods
Preparation of “Normal” Jell-O ®  — this must be done 24hrs before lesson so that Jell-O ® can set
1. Microwave 1 cup of tap water until hot
2. Add water to a mixing bowl and stir in 1 box of Jell-O ® powder until fully dissolved
3. Once fully dissolved add 1 cup of cold tap water
4. Pour Jell-O ® mixture into ice cube tray (will probably have extra mix that can be discarded)
5. Place ice cube tray into the refrigerator and allow to set overnight
6. Once Jell-O ® has set overnight carefully remove each “cube” from the tray and place all “cubes” into a

single re-sealable Tupperware container
Preparation of “Soft” Jell-O ® - this must be done 24hrs before lesson so that Jell-O ® can set

Microwave 2 cups of tap water until hot

Add water to a mixing bowl! and stir in 1 box of Jell-O ® powder until fully dissolved

Once fully dissolved add 2 cups of cold tap water

Pour Jell-O ® mixture into ice cube tray (will probably have extra mix that can be discarded)

Place ice cube tray into the refrigerator and allow to set overnight

Once Jell-O ® has set overnight carefully remove each “cube” from the tray and place all “cubes” into a
single re-sealable Tupperware container (Jell-O ® will be very soft, handle with care)

ogkrwnE

Preparation of “Stiff” Jell-O ®  — this must be done 24hrs before lesson so that Jell-O ® can set

Microwave 3/4 cup of tap water until hot

Add water to mixing bowl and stir in 1 box of Jell-O ® powder until fully dissolved

Pour Jell-O ® mixture into ice cube tray (will probably have extra mix that can be discarded)

Place ice cube tray into the refrigerator and allow to set overnight

Once Jell-O ® has set overnight carefully remove each “cube” from the tray and place all “cubes” into a
single re-sealable Tupperware container

agrwbRE

*These “hydrogels” have a stiffness that resembles fat (soft Jell-O ®) cartilage (normal Jell-O ®), and bone
(stiff Jell-O ®) so we encourage teachers to obtain some scraps (fat, cartilage, and bone) from a local
grocery store to allow students to do a direct comparison (touching them with gloves on)

**Also because of their different stiffness, if we were to encapsulate stem cells into these three different
hydrogels the cells would grow up to become fat cells, a.k.a adipocytes (soft Jell-O ®) cartilage cells, a.k.a.
chondrocytes (normal Jell-O ®), and bone cells, a.k.a osteoblasts (stiff Jell-O ®) (see attached literature).
9
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Demo #2: How Quick am 1?

During this demonstration students will investigate how hydrogel biomaterials can be modified to control how
quickly drugs are released in different tissue environments. Various hydrogels will be produced by altering the
weight % of gelatin incorporation. By modifying the number of cross-links (varying weight %) within the hydrogel
networks students will draw connections between hydrogel composition and rate of drug release.

Materials

- Gelatin (Knox original unflavored gelatin — 1 envelope, can be purchased at local grocery store)

- Tap water

- Measuring cup

- Mixing Bowls (4)

- Clear flat bottom mold (4) (plastic Petri Dishes work great & can be bought on Amazon for cheap)
- Microwave / Refrigerator

- Digital camera (optional)

- Stopwatch or wristwatch

- Plain white paper (4)

- Food coloring

Methods

Preparation of Gelatin — this must be done 24hrs before lesson so that gelatin can set
*Depending on the size of the class more than one “set” of gelatin molds can be made — the instructions below
describe how to make one set, the number of materials can be altered to make as many as needed

1. Microwave 1 cup of tap water until hot

2. Stirin 1 envelope of gelatin powder until fully dissolved (“gelatin base”)

3. Inabowl combine 1 part (1/4 cup) “gelatin base” to 5 parts (1 ¥ cup) tap water (label 1:5)

4. Pour mixture from step 3 into clear flat bottom mold — enough to fill ~ 1 cm deep

5. Inanew bowl combine 1 part (1/8 cup) “gelatin base” to 10 parts (1 ¥ cup) tap water (label 1:10)
6. Again, pour mixture from step 5 into clear flat bottom mold — enough to fill ~ 1 cm deep

7. In anew bowl combine 1 part (1/8 cup) “gelatin base” to 50 parts (6 ¥2 cup) tap water (label 1:50)
8. Again, pour mixture from step 7 into clear flat bottom mold — enough to fill ~ 1 cm deep

9. Finally, fill a clear flat bottom mold with tap water — enough to fill ~ 1 cm deep (label water only)
10. Place 4 molds (1:5, 1:10, 1:50, and water only) in refrigerator and allow them to set overnight

Diffusion Experiment — use food coloring to act as a model drug so it is easier to visualize diffusion
*For visualization purposes it is best to use blue or green food coloring, not yellow

Remove the gelatin molds (1:5, 1:10, 1:50, and water only) from the refrigerator
Place each molds on top of a piece of plain white paper (so it is easier to see diffusion of food coloring)
Let them come to room temperature (~ 5 min)
Place a single drop of food coloring on top of each gelatin mold exactly in the center (start watch)
Watch how the food coloring diffuses within each of the different molds
a. Have students write down their observations....
i. Immediately when the drop is added
ii. 2 min after the drop has been added
iii. 5 min after the drop has been added
iv. 10 min after the drop has been added
6. BONUS: use a digital camera to take pictures (from the top looking down) of each gelatin mold (1:5,
1:10, 1:50, and water only) at 2, 5, and 10 min (so 12 pictures in all)
7. DOUBLE BONUS: use the program ImageJ (free to download online) to quantify the area of food
coloring diffusion (using images in step 6) to calculate the coefficient of diffusion (diffusivity) for food
coloring traveling through each gelatin mold — see attached instructions for more details!

agrwNE
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Demo #3: Diffusivity Calculation (OPTIONAL)

During this activity students will have the opportunity to analyze their data like real scientist, turning pictures into
numbers. Students will use a free analysis program (ImageJ) made available by the National Institute of Health
(NIH) to calculate the area of food coloring diffusion for each gelatin mold at each time point observed (2, 5, and
10 min). Students will then plot a line of time (x-axis) versus diffusion area (y-axis) for each of the gelatin molds.
By calculating the slope of each line students will determine the diffusivity (units cmzls) of food coloring in each
of the gelatin molds and relate it back to the hydrogel composition.

Materials

- Digital camera

- Computer

- ImageJ software (Free to download from: http://rsb.info.nih.gov/ij/)
- Microsoft excel

- Images of food coloring and gelatin molds (from Demo #2)

- Quarter (25 cents)

Methods

PN PRE

8.
9.

Download and install ImageJ on computer

Upload gelatin + food coloring images to computer

Open ImageJ - select “File” > “Open” - select image from the computer

Once image is open select the “Polygon Selections” tool from the ImageJ tool bar

800,

Click on the edge of food coloring diffusion area to select the first point and then slowly trace the entire
outer edge of the food coloring diffusion area by selecting additional point all the way around.
a. The program will automatically close the loop when you get close enough

...outlining diffusion area... I

Once area is outlined select “Analyze” > “Set Measurement”
a. Select “Area” and unselect everything else
Select “Analyze” > “Measure”
a. Window will pop-up with area measurement (units are in pixles)
Record measurement (Microsoft excel) and repeat steps 3-7 for all images
Measure area of a quarter (image of a quarter) using ImageJ
a. The area of quarters face is 4.6 cm?® — this can be used to convert pixel area to cm?

10. Using Microsoft Excel create a line plot of Time (seconds; x-axis) versus Diffusion Area (cm?; y-axis)
11. Determine slope of each line which will give diffusivity (units cm?/s)

Society for Biomaterials Education Challenge
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Script for “Biomaterials for controlled delivery of cells and drugs: the helpful hydrogel”

Demo # 1: How Stiff am I?
Modifying Hydrogel Properties for Tissue Engineerin g & Stem Cell Delivery.

Jell-O is used to help students understand what biomaterials are, how biomaterials are designed to (a) better
match the stiffness of real tissues in the body, and (b) control stem cell behavior in regenerative medical
applications. This script is intended to be read by the educator, either read as-is to the class in conducting
the demonstration, or used as a guideline in preparing the lesson plan. Action statements are indicated in
italics. Start reading the script after the “introduction”. For additional depth, teachers can ask students to
create tables of their observations in their notebooks, in addition to discussing their observations as a group.

For the above-mentioned demonstration in class, you will need

1. “Normal” Jell-O (see Materials & Methods, Demo # 1) (Prepare in advance)

2. “Soft” Jell-O (see Materials & Methods, Demo # 1) (Prepare in advance)

3. “stiff “ Jell-O (see Materials & Methods, Demo # 1) (Prepare in advance)

4. Chicken (separated into fat, muscle, and bone) (Buy and prepare in advance. Bone and fat can
commonly be obtained for free from a butcher)

5. Gloves

6. Paper towels

Introduction (Script Starts)

Today, we are going to be learning about biomaterials. A biomaterial is any material that interacts with the
body to repair, change, or replace the bodies’ function. So this could be something complicated like a hip
replacement, that is used to replace a hip joint after its been damaged, or something simple like a band-aid,
that helps your body heal scrapes better by protecting them and keeping them clean. Can you think of any
other biomaterials?

(Students brainstorm- other examples include contact lenses, artificial heart valves, stitches, dentures...)

How stiff am 1? Understanding differences between d ifferent tissues

First, we are going to explore how stiff different tissues in the body are. A tissue is a structure in the body
made of similar cells that work together to do a specific job. We are going to look at fat, muscle, and bone
from chicken. Fat is made up of large, round fat cells, and helps keep the body warm and cushions your
internal organs when you jump, run, or fall. Muscle is made up of long, stretchy muscle cells, that contract
(squeeze together) to pull on your bones and make you move. If you flex your arm, while feeling your bicep,
you can feel how the muscle in your arm squeezes together to make your arm move.

(Demonstrate arm flexing and feeling the muscle contract).

Bone is the ridged, hard part of your body that give you your shape and hold you up. Some of them, like your
ribs, help keep your softer organs (like your stomach) from getting hurt when you fall. Bones are made up of
a lot of types cells, minerals, and other components that work together to give.

Distribute gloves to all the students in the class and ask them to wear gloves. At this time distribute scraps of
chicken fat, muscle and bone on a paper towel.

What you now see in front of you is a fat tissue. Using your hands, press a small portion of the tissue and
feel its stiffness.

This is muscle tissue. Using your hands, press a small portion of the tissue and feel its stiffness. Note the
differences between the two tissue types.

Lastly, we have bone. Using your hands, press a small portion of bone and feel its stiffness. Which one of
the three tissues you just saw is the hardest and which one is the softest?
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Students raise hands. Pick one student to answers the question.

Why do you think it is important for the different tissues in the body to have different stiffnesses?
(Students brainstorm- encourage them to think about what job the tissue has to do in the body, and what
stiffness it needs to do that job)

Collect used gloves and throw in trash. Distribute fresh pair of gloves and ask students to put them on.

Hydrogels
There are a lot of different kinds of biomaterials out there. One type is a hydrogel. A hydrogel is a crosslinked

polymer that is hydrophilic. Now what does that mean? A polymer is a chemical that is made up of many
repeats of the same unit (poly means many, and mer means parts- so a polymer is something made up of
many smaller parts). You can think of a polymer as a long string of beads- there are many beads that, when
strung together, make up one long chain.

(draw polymer of the board)

N Y o

A hydrogel is a crosslinked polymer. This means that there are many polymer chains that are tied together,
to make a basket-weave network. Imagine tying the strings of beads together into a mesh. You can make
nice, connected mesh networks by tying a lot of strings of beads together. That is how you make hydrogels-
you tie together (“crosslink”) many polymers into a mesh network.

(draw crosslinked network)

The last part of a hydrogel is that it is hydrophilic. This means it is water-loving meaning it can hold water in
its network pockets. So all together, a hydrogel looks like this:

(Draw hydrogel structure on the board)

Because hydrogels are also made up of mostly water, like your body (which is 50-70% water!) they are a
great biomaterial to use in the body. By changing the structure of the hydrogels, we can make hydrogels to
use in the different types of tissues in the body, for example the fat, muscle and bone we just investigated.
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Forming a Hydrogel
Now we will investigate how hydrogels can be used to mimic tissues of different stiffnesses.

Who has ever made Jell-O before?”

Let them raise their hands

Well, in order to make Jell-O we add hot water to the powder mix. The powder is gelatin- it is a kind of
polymer, the string of beads that tie together to make a crosslinked mesh network. The gelatin in Jell-O gets
tied together using heat energy from the water to form the Jell-O hydrogel. We are going to do a hands-on
experiment using Jell-O to better understand how we can modify hydrogel structure to control hydrogel
properties.

To do this everyone is going to need to put on gloves. Remember, SAFETY FIRST!

Hand out paper towels, and 3 different kinds of hydrogels (soft, stiff, and normal Jell-O)

As we hand out these hydrogel samples, don't touch them but take a moment and make some observations
about how they look. Other than being different colors, how do these hydrogels differ from each other?

(Let the students voice their observations)

Now everyone, take the paper towel and wiggle the Jell-O around on the table a little bit — How do the
hydrogels behave differently? Ok, now here is a question for everyone — Which hydrogel feels like a liquid,
and which hydrogel feels like a solid?

(Let students squish the gels with their hands)

If we could take a close up look at the structure of these gels which one do you think would look like
this...(draw on board)

... and which one do you think would look like this? (draw on board)

Does that make sense based on what we said about which one was more like a solid and which one was
more like a liquid? Increasing the amount of polymer in the hydrogel increases the number of crosslinks,
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which makes the gel behave more like a solid. That is exactly how we made three different stiffnesses of
hydrogel using the same Jell-O material- the softer ones have a lot more water in them than the stiff one.

We said that the more water there was in the hydrogel, the more fluid-like and soft it was. This is because of
the larger mesh size (§) within the hydrogel network. Mesh size is the size of the holes inside the hydrogel
network. The larger the mesh size, the more water is filling the hydrogel, and the softer and more water-like
the hydrogel will be.

(Draw the figure below)

The larger the mesh size is, the softer the hydrogel. We can make the mesh size of the hydrogel larger by
either using longer polymers, so there is more space between the crosslinks, or using less polymer (Jell-O)
to make the hydrogel, to increase the space between crosslinks. The amount of polymer used can be
measured in terms of “weight percent’- that means, by weight, how much of the hydrogel is made up of the
polymer. Higher weight percent polymer means there is more of the Jell-O in the hydrogel, and it will be
stiffer. Lower weight percent polymer means there is less Jell-O and more water in the hydrogel, and it will
be softer.

We can calculate what weight percent of the hydrogel is gelatin by dividing the weight that is gelatin by the
total weight of the gel. For example, our softest gels were made by combining 3 ounces of gelatin with 32
ounces of water (4 cups).

(do math on board)

So softest hydrogel is made up of 3/(3+32)*100%=8.5% gelatin. Our stiffest gels were made by combining 3
ounces of gelatin with 6 ounces water (3/4 cups). So the stiffest hydrogel is made up of 3/(3+6)*100=33%
gelatin.

Matching Tissue and Biomaterial Stiffnesses

When designing a biomaterial, it is important that the material matches the stiffness of the tissue. If the
material is too hard, it can damage the surrounding tissue and cause more harm than good. But if the
material is too soft, the surrounding tissue can damage it, and destroy the material before it can do its job! If
you were designing a replacement for bone, say for after someone had to have part of their bone removed
because of cancer, which of the Jell-O hydrogels would you use?

(wait for student discussion- stiffest gels)
What kinds of tissues could you use the other two types of hydrogel to replace?

(wait for student discussion- muscle for the middle, and fat or brain/neural tissue for the softest)
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Thought Experiment — if you were a cell in a hydrog el
So let’s talk a little more about how hydrogels can be used in biomedical engineering approaches to deliver
cells and help healing. How many people have heard of the special kind of cells called Stem Cells?

(Wait for students to answer)
Does anyone know what makes Stem Cells special?

Stem Cells are special because they can grow up to become any type of cell in your body! Stem cells can
both replace itself and become many kinds of more mature, grown-up cells. When a stem cell replaces itself,
it is called “self-renewal’- they are renewing themselves. They can be found in many tissues within the body,
including your bone marrow and fat. When stem cells become a more mature type of cell, it is called
differentiation. Think about this word- differentiation: it starts with different (stem cells are becoming
something different, a more mature type of cell) and ends with ation- which means action. So when cells
differentiate, they are becoming a different type of cell. This is one of the ways your body replaces cells when
they become old or damaged.

When stem cells become neural cells (from the brain or spinal cord), it is called neurogenic differentiation.
When they become the cells of the bone, it is called osteogenic differentiation. And when they become
muscle cells, it's called myogenic differentiation.

And cooler, Stem Cells can sense their environment and grow up to become a cell specific to that area of the
body

Sometimes, the body’s own stem cells are not able to fully heal and repair it after damage. Hydrogels can be
used to deliver Stem Cells within the body to help with this healing and repair. This is called Regenerative
medicine, which focuses on the use of stem cells to repair the body after it becomes damaged, or to replace
or help support part of the body if it can’t perform its job well enough. Regenerative medicine is a sub-group
of tissue engineering, and also involves the use of drugs to help repair or replace a biological function, so it
isn't restricted to only the use of stem cells.

If you were a Stem Cell and we put you in the softest hydrogel what might you grow up to become? What
types of tissue in the body are really soft?

(wait for guesses)

Maybe cartilage in your knee, or fat or brain tissue?

What if we put you in the hardest hydrogel? What kind of tissue might you grow up to become?
(wait for guesses)

What types of tissue in the body are really hard? — maybe bone?

(wait for guesses)

Finally, what about the medium gel? Muscle?

Just by changing the stiffness of the hydrogels we can control what kinds of tissues Stem Cells can become.
Collect gloves and hydrogels and throw them in the garbage

Summary

In summary we have learned that:
» Tissues have varying material properties (stiffnesses) based on their function
» Matching biomaterial and host tissue properties is a critical design consideration
» Hydrogels are highly crosslinked, hydrophilic networks
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» Hydrogel mesh size and stiffness can be controlled by varying the gel composition

e« Stem cells are an exciting, versatile cell type that can be used for a variety of therapeutic
applications

» Stem cell behavior (differentiation) can be controlled by altering biomaterial properties

» Biomaterials such as hydrogels can be used to deliver stem cells for therapeutic applications
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Demo # 2: How Quick am I?

Modifying Hydrogel Properties for Controlled Drug D elivery

By modifying the weight percentage of clear gelatin used to produce hydrogels, hydrogel mesh size will be
varied. Students will then add a model drug to the center of the hydrogel, and investigate the differences in
drug diffusion as a result of the differences in mesh size. Students will draw connections between the gel
properties and rate of drug release, and will apply their knowledge as they identify therapeutic applications
for each hydrogel network. If students do not have class notebooks to record their observations in, extra
paper should be provided for data collection.

For the above-mentioned demonstration in class, you will need following:

1. 1:5 gelatin molds, 1:10 gelatin molds, 1:50 gelatin molds, and water only (at room temperature) (see
Materials and Methods, prepare in advance)

Food coloring

Digital camera (Optional)

Stopwatch

Computer (Optional)

ImageJ software (Optional)

Excel software (Optional)

Plain white paper

©ONoO~WN

Introduction
Instead of putting Stem Cells in these hydrogels, what if we were to put medicine inside each of these gels?

(point to the large and small mesh size drawings on the board, add in circular “drug molecules”)

If we put drugs in these hydrogels, they would become a drug delivery system. “Drug delivery” involves
engineering systems to help with the delivery of a pharmaceutical agent, a drug, to a person or animal, to
achieve a therapeutic effect. That “therapeutic effect” could be something like reducing pain, or speeding up
healing. Drug delivery systems help get drugs where they're needed, at the levels they are needed. They
help reduce unwanted side effects by keeping drugs located only where they are needed.

Which one would let the medicine out first? The bigger one! Because it has more room inside of it for the
drug to move around and escape! On the other hand the tighter gel would let the medicine out more slowly.
The release of the drug from these hydrogel networks is controlled by diffusion, which is the process by
which atoms travel in a random path through a solution, eventually reaching an even distribution throughout
the entire solution volume. Diffusion happens based on random motion of the atoms, and does not require an
external force such as mixing.
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We have all heard the ads for painkillers that make your headache go away fast and keep it away all day —
well this is how it works — part of it is fast acting (point to large mesh size drawing) and part of it is long acting
(point to small mesh size drawing.

Now we move on to our next demo where we will understand how using gelatin at different concentrations
lets us control the rate at which drugs are released in different tissue environment.

Diffusion of dye in gelatin hydrogels
This demo can be done in groups of 5-6 students

| am going to give your group three types of gelatin hydrogels, labeled 1:5, 1:10, and 1:50 which have been
prepared by changing the weight% of gelatin. You will also have a dish containing only water. Place them on
top of a white paper, and label the paper with your initials and what each mold has in it.

Distribute the four dishes (containing 1:5, 1:10, and 1:50 water:gelatin, and plain water) to each group. Wait
for students to label their papers. Give students extra paper to record their observations on if they don’t have
class notebooks they are using to record the data.

Let me explain the difference between 1:5, 1:10 and 1:50 gelatin hydrogel. In 1:5, we have 1 part gelatin to 5
parts tap water. Similarly, 1:10 gelatin molds has 1 part gelatin and 10 parts tap water and so on. Therefore
1:5 is the hardest because it has the highest weight percentage that is gelatin, while 1:50 is the softest,
because it has the highest weight percentage water. Based on what we just learned about weight percent
and mesh size, which do you think would have the largest mesh size, and which would have the smallest?

Wait for students to guess about the differences in mesh size.

Right! The gels with the higher weight percentage gelatin will have smaller mesh sizes, which is why they are
stiffer. These differences in mesh size also cause them to have different diffusivity, which is what we’re going
to be investigating next.

You are going to write down your observation at (A) immediately when the drop is added, (b) 2 min after, (c)
5 min after, (d) 10 min after. If possible take pictures, or measure and record the diameter of the area the dye
covers, at these time points.

Have each group place a drop of blue food coloring at the center of each mold and start the timer.

Wait for at least 15 minutes to let the students make their observations
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1:5 1:10 1:50 Water
Gelatin:Water Gelatin:Water Gelatin:Water Only

5 min 2 min

10 min

What are the differences between the three molds with respect to diffusion of food coloring? Which mold
showed the fastest diffusion? Which had the slowest?

Encourage students to voice their observations.

Stiff gels (1:5 gelatin:water) allow slowest diffusion of dye while softest gelatin gels (1:50) allows most dye
diffusion. The water mold showed the most rapid mixing of the dye.

Thus using this simple experiment we learnt that by changing the properties of gels we can control how fast
or slow dye molecules travel (diffuse) into the neighboring tissues. This is one way that we can control the
release of drugs from a hydrogel network- if we put a drug in the 1:5 gelatin hydrogel, it will release the drug
much more slowly than the 1:50 gelatin hydrogel would.

Collect molds and trash them

Summary
In summary we have learned that:

- Biomaterials like hydrogels can be used to deliver drugs

< Diffusion is the process where molecules move from areas of high to low concentration

« Hydrogel mesh size can be used to control the rate of drug diffusion within the hydrogel

e Material properties such as mesh size can be altered to control drug release for therapeutic
applications

« Collection and graphical representation of data can provide useful insight to the biomaterial system
being investigated
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Post-Lesson Worksheet
1 If you formed a hydrogel by combining 15 g of gelatin and 45 g of water, what weight
percentage (wt%) of the gel would be gelatin? Show your work.

2 If you wanted to make a hydrogel that was 7 wt% gelatin, and wanted the total weight of
the hydrogel to be 50 g, how much water and gelatin would you combine? Show your
work.

3 Why is it important to match the stiffness of a biomaterial to the stiffness of the tissue it
will be used in?

4 What is special about stem cells?

5 Describe one way hydrogels can be used:
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6 Give one example of a biomaterial:

7 Why would you want to delivery drugs from a biomaterial?

8 Describe how we controlled how fast the “drug” (blue dye) diffused in the hydrogels:
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For questions 9-15, Hydrogel A is 1 wt% gelatin and 99 wt% water, hydrogel B is 15 wt% gelatin
and 85 wt% water, and hydrogel C is 40 wt% gelatin and 60 wt% water.

9 Label each diagram above with which hydrogel it corresponds to
10 Which hydrogel will have the largest mesh size?
11 Rank the hydrogels from softest to stiffest:
12 Which hydrogel will release drug the slowest?
13 Which hydrogel should be used to replace:
a Fattissue?
b Bone tissue?
¢ Muscle tissue?

14 Which hydrogel would cause osteogenic differentiation of stem cells grown on it?

15 Which hydrogel would cause myogenic differentiation of stem cells grown on it?
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Post-Lesson Worksheet Key  40/40
1 If you formed a hydrogel by combining 15 g of gelatin and 45 g of water, what weight
percentage (wt%) of the gel would be gelatin? Show your work. 4 pts

15/(15+45) * 100% = 25%

2 If you wanted to make a hydrogel that was 7 wt% gelatin, and wanted the total weight of
the hydrogel to be 50 g, how much water and gelatin would you combine? Show your
work. 5 pts

50 g * 0.07 = 3.5 g gelatin
50 g total - 3.5 g gelatin = 46.5 g water

3 Why is it important to match the stiffness of a biomaterial to the stiffness of the tissue it
will be used in? 3 pts

If the biomaterial is too stiff it can damage the n  earby tissue, but if the biomaterial
is too soft the nearby tissue can damage it.

4 What is special about stem cells? 3 pts
Stem cells can both divide and make more of themsel  ves (self-renew) and become
other cell types (differentiate). They can become m  any different types of cells in
the body, instead of just one type, and can replace and repair damaged tissue.

5 Describe one way hydrogels can be used:3 pts
There are many correct answers: for long term deliv.  ery of a drug, to replace
damaged tissue, to deliver therapeutic cells, to gr ~ ow an organ in the lab...
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6 Give one example of a biomaterial: 3 pts
There are many correct answers: a Band-Aid, stitche s, a hip implant, a cast,
crutches, contacts... anything that interacts with th e body to help repair, replace
or support the body’s natural function

7 Why would you want to delivery drugs from a biomaterial? 3 pts
To get drugs only where you need them, instead of e verywhere throughout the

body, at the levels you need them to have an effect

8 Describe how we controlled how fast the “drug” (blue dye) diffused in the hydrogels: 3

pts
We changed the mesh size by changing the amount of gelatin (polymer) in the
hydrogel. By increasing the weight percent gelatin in the hydrogel, we decreased

the mesh size and decreased the rate of drug diffus  ion in the gel.
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For questions 9-15, Hydrogel A is 1 wt% gelatin and 99 wt% water, hydrogel B is 15 wt% gelatin
and 85 wt% water, and hydrogel C is 40 wt% gelatin and 60 wt% water. 1 pt each

A C B

9 Which hydrogel will have the largest mesh size? A
10 Rank the hydrogels from softest to stiffest: A, B, C
11 Which hydrogel will release drug the slowest? C
12 Which hydrogel should be used to replace:
a Fattissue? A
b Bonetissue? C
c Muscle tissue? B
13 Which hydrogel would cause osteogenic differentiation of stem cells grown on it? C

14 Which hydrogel would cause myogenic differentiation of stem cells grown on it? B
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Scientific Vocabulary:

Biomaterial:
Any material that interacts with the body to repair, augment, or replace the bodies’
function.

Crosslinking:
How the individual strands of a polymer tie together in a chemical bond (either ionic or
covalent, depending on the system) to make the mesh-like hydrogel polymer network.

Differentiation:
When a stem cell becomes a more mature (more specialized) type of cell.

Diffusion:
The process by which atoms travel in a random path through a solution, eventually
reaching an even distribution throughout the entire solution volume. Diffusion happens
based on random motion of the atoms, and does not require an external force such as
mixing. It is the process where molecules move from areas of high to low concentration.

Drug Delivery:
Engineering systems to help with the delivery of a pharmaceutical agent to a person or
animal, to achieve a therapeutic effect. Drug delivery systems help get drugs where
they're needed, at the levels needed to have the desired effect.

Hydrogel:
A highly connected polymer network that contains a large amount (>50%) of water.

Hydrophilic:
Water-loving. Easily interacts with water.

Hydrophobic:
Water-hating. Repels water.

Mesh Size:
The size of the holes within a hydrogel network. This controls many properties of the
network, such as stiffness and diffusion within the hydrogel.

Modulus of Elasticity:
A measure of the stiffness of a material.

Myogenic:
Forming muscle tissue.
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Neural:
Relating to the brain or nervous system (brain, spinal cord, peripheral nerves).

Neurogenic:
Forming neural (brain/nervous) tissue.

Osteogenic:
Forming bone tissue.

Polymer:
A chemical compound made of repeating units. They can be derived from nature or
created in a chemical synthesis lab, and are commonly used in biomaterials engineering.

Self-Renewal:
When a stem cell divides to make two daughter cells identical to the original cell.

Stem Cell:
A special subset of cells within the body that can both replace itself and become many
kinds of more mature cells. They can be found in many tissues within the body, including
bone marrow and fat.

Tissue Engineering:
The use of cells, biomaterials, and therapeutic compounds to repair or replace a
biological function. This encompasses the field of regenerative medicine, which focuses
more on the use of stem cells to achieve the desired effect.

Weight Percent:
By weight, how much of the material is made up of one component. It is calculated by
WaWiia*100%, where W, is the weight of the component of interest and Wiy is the
total weight of the system.
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